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Thank you for choosing our product. Please read the instructions carefully 

before operation. Follow these instructions to ensure that the product is 

functioning properly. The images shown in this manual are for illustrative 

purposes only. 

For further details, please visit our Company’s website 

www.zkteco.com. 
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Copyright © 2021 ZKTECO CO., LTD. All rights reserved. 

Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any 

way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or 

"ZKTeco"). 

Trademark 

  is a registered trademark of ZKTeco. Other trademarks involved in this manual are owned by 

their respective owners. 

Disclaimer 

This manual contains information on the operation and maintenance of the ZKTeco equipment. The 

copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is 

the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third 

party without express written permission of ZKTeco. 

The contents of this manual must be read as a whole before starting the operation and maintenance of the 

supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please contact 

ZKTeco before starting the operation and maintenance of the said equipment.  

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and 

maintenance personnel are fully familiar with the design and that the said personnel have received 

thorough training in operating and maintaining the machine/unit/equipment. It is further essential for the 

safe operation of the machine/unit/equipment that personnel has read, understood and followed the safety 

instructions contained in the manual. 

In case of any conflict between terms and conditions of this manual and the contract specifications, 

drawings, instruction sheets or any other contract-related documents, the contract conditions/documents 

shall prevail. The contract specific conditions/documents shall apply in priority. 

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information 

contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty of 

any kind, including, without limitation, any warranty of design, merchantability or fitness for a particular 

purpose. 

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which 

are referenced by or linked to this manual. The entire risk as to the results and performance obtained from 

using the information is assumed by the user. 

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect, 

special, or exemplary damages, including, without limitation, loss of business, loss of profits, business 

interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or relating 

to the use of the information contained in or referenced by this manual, even if ZKTeco has been advised of 

the possibility of such damages.  

This manual and the information contained therein may include technical, other inaccuracies or 

typographical errors. ZKTeco periodically changes the information herein which will be incorporated into 

new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the 

information contained in the manual from time to time in the form of circulars, letters, notes, etc. for better 

operation and safety of the machine/unit/equipment. The said additions or amendments are meant for 
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improvement /better operations of the machine/unit/equipment and such amendments shall not give any 

right to claim any compensation or damages under any circumstances. 

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any non-

compliance of the instructions contained in this manual (ii) in case of operation of the 

machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in 

conditions different from the prescribed conditions of the manual. 

The product will be updated from time to time without prior notice. The latest operation procedures and 

relevant documents are available on http://www.zkteco.com 

If there is any issue related to the product, please contact us. 

ZKTeco Headquarters 

Address ZKTeco Industrial Park, No. 32, Industrial Road,  

Tangxia Town, Dongguan, China. 

Phone  +86 769 - 82109991  

Fax  +86 755 - 89602394 

For business related queries, please write to us at: sales@zkteco.com. 

To know more about our global branches, visit www.zkteco.com.   

http://www.zkteco.com/
mailto:sales@zkteco.com
http://www.zkteco.com/


MB10-VL                              User Manual 

P a g e  | 3   Copyright©2021 ZKTECO CO., LTD.  All rights reserved. 

About the Company 

ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein) 

readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition 

Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and 

Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security 

solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art 

700,000 square foot ISO9001-certified manufacturing facility, we control manufacturing, product design, 

component assembly, and logistics/shipping, all under one roof. 

The founders of ZKTeco have been determined for independent research and development of biometric 

verification procedures and the productization of biometric verification SDK, which was initially widely 

applied in PC security and identity authentication fields. With the continuous enhancement of the 

development and plenty of market applications, the team has gradually constructed an identity 

authentication ecosystem and smart security ecosystem, which are based on biometric verification 

techniques.  With years of experience in the industrialization of biometric verifications, ZKTeco was officially 

established in 2007 and now has been one of the globally leading enterprises in the biometric verification 

industry owning various patents and being selected as the National High-tech Enterprise for 6 consecutive 

years. Its products are protected by intellectual property rights. 

About the Manuals 

This manual introduces the operations of MB10-VL Product. 
All figures displayed are for illustration purposes only. Figures in this manual may not be exactly consistent 

with the actual products. 

Features and parameters with ★  are not available in all devices.  
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Document Conventions 

Conventions used in this manual are listed below: 

GUI Conventions 

For Software 

Convention Description 

Bold font Used to identify software interface names e.g. OK, Confirm, Cancel  

> 
Multi-level menus are separated by these brackets. For example, File > Create > 
Folder. 

For Device 

Convention Description 

< > Button or key names for devices. For example, press <OK> 

[ ] 
Window names, menu items, data table, and field names are inside square 
brackets. For example, pop up the [New User] window 

/ 
Multi-level menus are separated by forwarding slashes. For example, 
[File/Create/Folder]. 

 

Symbols 

Convention Description 

 
This implies about the notice or pays attention to, in the manual 

 
The general information which helps in performing the operations faster 

 The information which is significant 

 Care taken to avoid danger or mistakes 

 
The statement or event that warns of something or that serves as a cautionary 
example. 
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Safety Measures 

The below instructions intend to ensure that the user can use the product correctly to avoid danger or 

property loss. The following precautions are to keep users safe and prevent any damage. Please read 

carefully before installation. 

 Noncompliance with instructions could lead to product damage or physical injury (may even cause 

death). 

1. Read, follow, and retain instructions - All safety and operational instructions must be properly 

read and followed before bringing the device into service. 

2. Do not ignore warnings - Adhere to all warnings on the unit and in the operating instructions. 

3. Accessories - Use only manufacturer-recommended or product-sold accessories. Please do not use 

any other components other than manufacturer suggested materials. 

4. Precautions for the installation - Do not place this device on an unstable stand or frame. It may fall 

and cause serious injury to persons and damage to the device. 

5. Service - Do not try to service this unit yourself. Opening or removing covers may expose you to 

hazardous voltages or other hazards. 

6. Damage requiring service - Disconnect the system from the Mains AC or DC power source and 

refer service personnel under the following conditions: 

• When cord or connection control is affected, 

• When the liquid spilled or an item dropped into the system, 

• If exposed to water or due to inclement weather (rain, snow, and more), 

• And if the system is not operating normally, under operating instructions. 

Just change controls defined in operating instructions. Improper adjustment of the controls may 

result in damage and involve a qualified technician to return the device to normal operation. 

And do not connect multiple devices to one power adapter as adapter overload can cause over-heat 

or fire hazard. 

7. Replacement parts - When replacement parts are needed, service technicians must only use 

replacement parts provided by the supplier. Unauthorized substitutes can result in a burn, shock, or 

other hazards. 

8. Safety check - On completion of service or repair work on the unit, ask the service technician to 

perform safety checks to ensure proper operation of the device. 

9. Power sources - Operate the system only from the label's power source form. If the sort of power 

supply to use is unclear, call your dealer. 

10. Lightning - Can install external lightning conductors to protect against electrical storms. It stops 

power-ups from destroying the system. 

Recommended installing the devices in areas with limited access.  
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Electrical Safety 

• Before connecting an external cable to the device, complete grounding properly, and set up surge 

protection; otherwise, static electricity will damage the mainboard. 

• Make sure that the power has been disconnected before you wire, install, or dismantle the device. 

• Ensure that the signal connected to the device is a weak-current (switch) signal; otherwise, 

components of the device will get damaged. 

• Ensure that the standard voltage applicable in your country or region is applied. If you are not sure 

about the endorsed standard voltage, please consult your local electric power company. Power 

mismatch may cause a short circuit or device damage. 

• In the case of power supply damage, return the device to the professional technical personnel or your 

dealer for handling. 

• To avoid interference, keep the device far from high electromagnetic radiation devices, such as 

generators (including electric generators), radios, televisions, (especially CRT) monitors, or speakers. 

Operation Safety 

• If smoke, odour, or noise rise from the device, turn off the power at once and unplug the power cable, 

and then please contact the service centre. 

• Transportation and other unpredictable causes may damage the device’s hardware. Check whether 

the device has any intense damage before installation. 

• If the device has major defects that you cannot solve, contact your dealer as soon as possible. 

• Dust, moisture, and abrupt temperature changes can affect the device's service life. You are advised 

not to keep the device under such conditions. 

• Do not keep the device in a place that vibrates. Handle the device with care. Do not place heavy 

objects on top of the device. 

• Do not apply rosin, alcohol, benzene, pesticides, and other volatile substances that may damage the 

device enclosure. Clean the device accessories with a piece of soft cloth or a small amount of cleaning 

agent. 

• If you have any technical questions regarding usage, contact certified or experienced technical 

personnel.  
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 Note 

• Make sure whether the positive polarity and negative polarity of the DC 12V power supply is 

connected correctly. A reverse connection may damage the device. It is not advisable to connect the 

AC 24V power supply to the DC 12V input port. 

• Make sure to connect the wires following the positive polarity and negative polarity shown on the 

device's nameplate. 

• The warranty service does not cover accidental damage, damage caused by mis-operation, and 

damage due to independent installation or repair of the product by the user.  
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1 Instruction for Use 

 Finger Positioning 

Index, middle, or ring finger are the recommended fingers to use, and avoid using thumb or pinkie as they 

are difficult to position correctly on the fingerprint reader and get suitable output. 

 

 

Note: the recommended method when pressing your fingers onto the fingerprint reader for registration 

and identification. Our company will assume no liability for recognition issues that may result from incorrect 

usage of the product. We reserve the right of final interpretation and modification concerning this point.  

 

 Standing Position, Facial Expression and Standing Posture 

 The recommended distance 

   

It is recommended to have a 0.3-0.5m 

space between the device and the 

customer whose height is 1.55m to 

1.85m. Users may slightly move forwards 

and backward to improve the quality of 

facial images captured. 

Too close to the edge 

Vertical 

Too low 
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 Facial expression 

 

 Standing posture 

 

Note: During enrolment and verification, please remain natural facial expression and standing posture. 
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 Face Registration 

Try to keep the face in the centre of the screen during registration. Please face the camera and stay still 

during face registration. The screen looks like the image below: 

 

 

Correct face registration and authentication method 

 Cautions for registering a face 

 When registering a face, maintain a 40cm to 80cm space between the device and the face. 

 Be careful not to change the facial expression. (smiling face, drawn face, wink, etc.) 

 If you do not follow the instructions on the screen, the face registration may take longer or may 

fail. 

 Do not cover your eyes or eyebrows. 

 Do not wear hats, masks, sunglasses, or eyeglasses. 

 Be careful not to display two faces on the screen. It may create confusion and the registration 

may fail. 

 A user wearing glasses should register their face both with and without glasses. 

 

 Cautions for authenticating a face 

 Ensure that the face appears inside the guideline displayed on the screen of the device. 

 For a person wearing glasses, try authenticating your face with glasses if glasses were used 

while registering, or else authenticate without glasses if glasses were not used while 

registration. Otherwise, the recognition may fail or can be difficult. Also, if a different pair of 

glasses is used than the one used during registration, authentication can also fail. In such a case, 

the previously worn glasses can be used for authentication. 

 If a part of the face is covered by a hat, a mask, an eye patch, or sunglasses, the authentication 

may fail. Do not cover the face and allow the device to recognize the eyebrows and other 

features of the face. 
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 Verification Mode 

1.4.1 Fingerprint Verification 

 1: N fingerprint verification mode 

It compares the current fingerprint with all the fingerprint data that is available in the device. The device 

enters the fingerprint authentication mode when a user presses his/her finger onto the fingerprint scanner.  

Please follow the recommended way to place your finger onto the sensor. For details, please refer to 1.1 

Finger Positioning. 

The following screen displays on successful and failed verification respectively. 

 

 

  

On successful verification On failed verification 

 1:1 fingerprint verification mode 

It compares the current fingerprint with the linked fingerprints to the entered User ID via the virtual 

keyboard. Users can try verifying their identity with 1:1 verification mode if they are unable to get access 

with the 1:N authentication method. 
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Enter the User ID on the main screen to enter 1:1 fingerprint verification mode. 

1. Enter the user ID and press [M/OK]. 

If the user has registered a face, a password and card in addition to his/her fingerprints and the 

verification method is set to password/ fingerprint/ card/ face verification, the following screen will 

appear. Select the fingerprint icon to enter fingerprint verification mode: 

 

2. Press the fingerprint to verify. 

The following screen displays on successful and failed verification respectively. 

  

 

  

On successful verification On failed verification 
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1.4.2 Facial Verification 

 1:N Facial Verification  

It compares the current acquired facial images with all the face data registered in the device. The following 

is the pop-up prompt box of comparison result. 

   

 1:1 Facial Verification  

It compares the face captured by the camera with the facial template related to the entered user ID.  

For 1:1 facial verification, enter the User ID on the main interface and enter the 1:1 facial verification mode. 

Enter the user ID and press [M/OK]. 

If an employee has registered a password in addition to face, the following screen will appear. Select the 

face icon to enter face verification mode. 
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After successful verification, the following display screen appears.  

 

If the verification fails, it prompts “Please adjust your position!”. 

1.4.3 Password Verification 

It compares the entered password with the registered User ID and password.  

Enter the User ID on the main screen to enter the 1:1 password verification mode.  

1. Enter the user ID and press [M/OK]. 

If an employee has registered fingerprint and face in addition to password, the following screen will appear. 

Select the Password icon to enter password verification mode.  
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2. Input the password and press [M/OK]. 

 

The following screen displays on successful and failed verification respectively. 

 

 

 

On successful verification On failed verification 

1.4.4 Card Verification  

Only the product with the card module offers the card verification function. 

 1:N Card Verification  

It compares the card number in the card induction area with all the card number data that is available in the 

device. The device enters the Card Verification mode when a user put his/her card on the induction area. 

The following screen displays on successful and failed verification respectively. 
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On successful verification On failed verification 

 1:1 Card Verification  

It compares the card number in the card induction area with the number associated with the employee's 

User ID registered in the device. Users can try verifying their identity with 1:1 verification mode if they are 

unable to get access with the 1:N authentication method. 

Enter the User ID on the main screen to enter 1:1 card verification mode. 

1. Enter the user ID and press [M/OK]. 

If the user has registered a face and a password in addition to his/her card, and the verification method 

is set to password/ fingerprint/ card/ face verification, the following screen will appear. Select the 

card icon to enter card verification mode: 
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2. Place the card in the card induction area to verify. After successful verification, the following display 

screen appears. 

   

1.4.5 Combined Verification  

For enhanced security, this device offers the option of using multiple forms of verification methods, as 

shown in the picture below.  

   

Note: 

1） "/" means “or”, and "+" means “and”. 

2） You must register the required verification information before using the combination verification 

mode, otherwise the verification may fail. For example, if a user uses Face Registration but the 

verification mode is Face + Password, then the user won't be able to pass verification. 
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2 Main Menu 

Click [M/OK] on the initial interface to enter the main menu, as shown below:  

   

Items Descriptions 

User Mgt. To add, edit, view, and delete basic information of a user. 

User Role 
To set the permission scope of the custom role and enroller, that is, the rights to 

operate the system. 

COMM. 
To set the relevant parameters of Ethernet, PC connection, wireless network,  

cloud server setting and network diagnosis. 

System 
To set parameters related to the system, including date & time, attendance, face, 

fingerprint, reset and USB upgrade. 

Personalize 
To customize settings of interface display, including user interface, voice, bell 

schedules, punch state options and shortcut key mappings. 

Data Mgt. To delete all relevant data in the device. 

Department 
Establish the organizational structure of the department, including functions like 

adding, editing, or deleting the department, and scheduling the department, etc. 

Shift set 
Set attendance rules and the number of shifts to be used, and schedule employees. 

The device supports up to 24 shifts. 

Report 

Use USB flash drive to download the attendance statistics form to check on the 

computer or download the attendance settings form to set shifts on the computer, 

assign shifts to employees and then upload the attendance settings form. At this 

time, the device will give priority to the use of the schedule of the settings form. 



MB10-VL                              User Manual 

P a g e  | 21   Copyright©2021 ZKTECO CO., LTD.  All rights reserved. 

Access Control To set the parameters of the lock and the relevant access control device. 

USB Manager 
To transfer data such as user data and attendance logs from the USB disk to the 

supporting software or other devices. 

Attendance 

Search 
Query the specified access record, check attendance photos, and blacklist photos.  

Auto test 
To automatically test whether each module functions properly, including the 

screen, audio, camera, and real-time clock. 

System Info To view data capacity, device, and firmware information of the current device. 
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3 User Management 

 Adding Users 

Select User Mgt. on the main menu and select New User.  

 

 Register a User ID and Name 

Enter the User ID and Name by selecting the respective options. 

 

Note:  

1） A username can contain a maximum of 17 characters. 

2） The user ID may contain 1-9 digits by default. 

3） You can modify your ID only during the initial registration and can't be modified later. 

4） The User ID cannot be duplicated. If there is a voice prompt about duplicate User ID, then you need 

to choose another User ID that should be unique. 
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 Setting the User Role 

There are two types of user accounts: Normal Users and Super Admin. If there is already a registered 

administrator, the normal users have no rights to manage the system and may only access authentication 

verifications. The administrator owns all management privileges. If a custom role is set, you can also select 

custom role permissions for the user.  

Select User Role to set Normal User or Super Admin.  

 

Note: If the selected user role is the Super Admin, the user must pass the identity authentication to access 

the main menu. The authentication is based on the authentication method(s) that the super administrator 

has registered. 

 Setting the Verification Mode 

The verification mode available in the device are: 

• Password/ Fingerprint/ Card/ Face • Password + Card 

• Fingerprint only • Password/ Card 

• User ID only • User ID + Fingerprint + Password 

• Password • Fingerprint + (Card/ User ID) 

• Card only • Face only 

• Fingerprint/ Password • Face + Fingerprint 

• Fingerprint/ Card • Face + Password 

• User ID + Fingerprint • Face + Card 

• Fingerprint + Password • Face + Fingerprint + Card 

• Fingerprint + Card • Face + Fingerprint + Password 

• Fingerprint + Password + Card  

Select the required Verification Mode to set individual verification mode for the user. Select M/OK to save 

and return to the New User interface. 



MB10-VL                              User Manual 

P a g e  | 24   Copyright©2021 ZKTECO CO., LTD.  All rights reserved. 

   

 Register fingerprint 

Select Fingerprint to enter the enroll fingerprint page. Users can choose one or more fingerprint(s) to enroll. 

Press the finger horizontally onto the fingerprint sensor. The registration interface is shown below: 

   

 Register Face 

Select Face on the Verification mode to enter the face registration page. Users need to face the camera such 

that their whole face is visible on the device's screen and all the important features of the face are visible. 

Then stay still for a while during face registration. The registration interface is as follows:  
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 Register Card 

Select Card on the Verification mode page to enter the card registration page. On the Card interface, 

swipe the card underneath the card reading area. The card registration will be successful. 

If the card is registered already then, the “Duplicate Card” message shows up. The registration interface is 

as follows: 

 

 Register password 

Select Password on the Verification mode page to enter the password registration page. Enter a password 

and re-enter it. Select M/OK. If the two entered passwords are the same, the system will return to the New 

User interface. 
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Note: The password may contain one to eight digits by default. 

 Register user photo 

When a user registered with a photo passes the authentication, the registered photo will be displayed. 

Select User Photo, Select M/OK to take a photo. Then Select ESC to exit and return to the New User interface. 

Note: While registering a face, the system will automatically capture a picture as the user photo. If you do 

not want to register a user photo, the system will automatically set the picture captured as the default photo. 

 Search for Users 

Select the All Users option in the User Mgt. Then enter the retrieval keyword in the search bar of the user 

list (keyword may be an ID, surname, or full name). The system will search for the users related to the entered 

information. 
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 Edit Users 

Choose a user from the list and select Edit to enter the Edit user interface: 

   

Note: The operation of editing a user is the same as that of adding a user, except that the user ID cannot be 

modified when editing a user’s detail. 

 Deleting Users 

Choose a user from the list and select Delete to enter its interface. Select the user information to be deleted 

and click M/OK. 

   

Note: 

If you select Delete User, all information of the user will be deleted. Only fingerprint data is removed 

if Delete Fingerprint Only is selected. Only face data is removed if Delete Face Only is selected. And only 

the password is removed if Delete Password Only is selected. 
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4 User Role 

If you need to assign any specific permissions to certain users, you may edit the “User Defined Role” under 

the User Role menu. 

You may set the permission scope of the custom role (up to 3 roles) and enroller. 

Select User Role on the main menu interface. 

 

1. Select an item to set a defined role. Select the Enable Defined Role option to enable this defined role. 

Select Name and enter the name of the role. 
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2. Select Define User Role to assign the privileges to the role. Click ESC to save and return after the 

privilege assignment is complete. 

 

Note: You need to select the features in sub-menus. If the device has a role enabled, you may assign the 

roles you set to users by selecting User Mgt. > New User > User Role. 

 

If no super administrator is registered, the device will prompt "Please register super administrator user 

first!” after selecting the enable bar. 
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5 Communication Settings 

Select COMM. on the main menu to get into communication settings and set parameters of the network, PC 

connection, WIFI, and cloud server. 

 

 Network Settings 

When the device needs to communicate with a PC over the Ethernet, you need to configure network settings 

and ensure that the device and the PC are connecting to the same network segment.  

Select Ethernet on the Comm. Settings interface.  
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Item Descriptions 

IP Address 
The factory default value is 192.168.1.201. Please set them according to the 

actual network situation. 

Subnet Mask 
The factory default value is 255.255.255.0. Please set them according to the 

actual network situation. 

DNS 
The factory default address is 0.0.0.0. Please set them according to the actual 

network situation. 

TCP COMM. Port 
The factory default value is 4370. Please set them according to the actual 

network situation. 

DHCP 
Dynamic Host Configuration Protocol helps in dynamically allocating IP 

addresses for clients via server. 

Display in Status Bar To set whether to display the network icon on the status bar. 

 

 PC Connection 

To improve the security of data, please set a Comm Key for communication between the device and the PC.  

The connection password needs to be entered before the device can be connected to the PC software if a 

Comm Key is set.  

Select PC Connection on the Comm. Settings interface to set Comm Key.  

 

Item Descriptions 

Comm Key 
The default password is 0, which can be changed later. The Comm Key may 

contain1-6 digits. 

Device ID 

It is the identification number of the device, which ranges between 1 and 254. If 

the communication method is RS232/RS485, you need to input this device ID in 

the software communication interface. 



MB10-VL                              User Manual 

P a g e  | 32   Copyright©2021 ZKTECO CO., LTD.  All rights reserved. 

 Wireless Network 

 The device provides a Wi-Fi module, which can be built-in within the device module or can be externally 

connected. 

The Wi-Fi module enables data transmission via Wi-Fi (Wireless Fidelity) and establishes a wireless network 

environment. Wi-Fi is enabled by default in the device. If you don't need to use the Wi-Fi network, you can 

toggle the Wi-Fi to disable the button. 

Select Wireless Network on the Comm. settings interface to configure the Wi-Fi settings. 

Search the WIFI Network 

 WIFI is enabled in the device by default. Toggle the  button to enable or disable WIFI. 

 Once the Wi-Fi is turned on, the device searches for the available WIFI within the network range. 

 Choose the required Wi-Fi name from the available list and input the correct password in the 

password interface, and then select Connect to WIFI (OK) and press [M/OK] to confirm. 

 

 

 

WIFI Enabled: Choose the required 

network from the searched network 

list. 

 Click the password field to enter the 

password, and then select Connect to 

WIFI (OK) and press [M/OK] to save. 

 When the WIFI is connected successfully, the initial interface will display the Wi-Fi  logo. 

Add WIFI Network Manually 

The Wi-Fi can also be added manually if the required Wi-Fi does not show on the list. 
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Select Add WIFI Network to add the 

WIFI manually and press [M/OK]. 

 On this interface, enter the WIFI 

network parameters (the added 

network must exist.) 

Note: After successfully adding the WIFI manually, follow the same process to search for the added WIFI 

name. 

Advanced Setting 

On the Wireless Network interface, select Advanced to set the relevant parameters as required. 

 

 

 

Function Description 

Function Name  Description 

DHCP 
Dynamic Host Configuration Protocol (DHCP) dynamically allocates IP addresses 
to network clients. If the DHCP is enabled, then the IP cannot be set manually. 
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IP Address 
The IP address for the WIFI network, the default is 0.0.0.0. It can be modified 
according to the network availability. 

Subnet Mask 
The default Subnet Mask of the WIFI network is 255.255.255.0. It can be modified 
according to the network availability. 

Gateway  
The default Gateway address is 0.0.0.0. It can be modified according to the network 
availability. 

 

 Cloud Server Setting 

The Cloud Server setting option helps to set different configurations used for connecting with the ADMS 

server. 

Select Cloud Server Setting on the Comm. Settings interface. 

 

Item Description 

Enable Domain 

Name 
Server Address 

When enabled, the domain name mode “http://...” is used, such as 

http://www.XYZ.com, while “XYZ” denotes the domain name. 

Disable 

Domain Name 

Server Address The IP address of the ADMS server. 

Server Port Port used by the ADMS server. 

Enable Proxy Server 
When a proxy is enabled, you need to set the IP address and port 

number of the proxy server. 

HTTPS 

It is an HTTP channel with security as its goal. Based on HTTP, 

transmission encryption and identity authentication ensure the 

security of the data transmission process. 
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 Network Diagnosis 

It helps to set the network diagnosis parameters. 

Select Network Diagnosis on the Comm. settings interface. Enter the IP address that needs to be diagnosed 

and click Start the diagnostic test to check whether the network can connect to the device. 
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6 System Settings 

It helps to set related system parameters to optimize the performance and usability of the device.  

Select System on the main menu interface.  

 

 Date and Time 

Select Date Time on the System Setting interface.  

 

Item Descriptions 

Manual Date and Time Can set date and time manually and click [M/OK] to save. 

24-Hour Time The device displays 24-Hour time format, when enabled. 

Date Format Select the date format. 
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Note: 

When restoring the factory settings, the time (24-hour) and the date format (YYYY-MM-DD) can be restored 

to default, but the device date and time cannot be restored.  

For example, the user sets the time of the device (18:35 on March 15, 2019) to 18:30 on January 1, 2020. After 

restoring the factory settings, the time of the device will remain 18:30 on January 1, 2020. 

 Attendance Setting 

Select Attendance on the System interface to alter the attendance rules as required. 

 

Item Description 

Duplicate Punch 

Period (m) 

Within a set time (unit: minutes), the duplicated attendance logs will not be 

reserved (value ranges from 1 to 999999 minutes). 

Attendance Log Alert 

When the remaining storage is smaller than the set value, the device will 

automatically alert users to the remaining storage information. It can be 

disabled or set to a value ranged from 1 to 9999. 

Periodic Del of ATT 

Data 

The number of attendance logs allowed to be deleted at once when the 

maximum storage is attained. It can be disabled or set to a value ranged from 

1 to 999. 

Authentication 

Timeout(s) 

The time interval for which the "Successful Verification" message displays. 

Valid value: 1~9 seconds. 

Face comparison 

Interval(s) 

To set the time interval for facial template matching as required. 

Valid value: 0~9 seconds. 
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 Face Parameters 

Select Face option on the System interface. 

 

Item Description 

1:N Threshold 

Value 

Under 1:N verification mode, the verification will only be successful when the 

similarity between the acquired facial image and all registered facial templates 

is greater than the set value. 

The valid value ranges from 0 to 100. The higher the thresholds, the lower the 

misjudgement rate and higher the rejection rate, and vice versa. The default 

value of 47 is recommended. 

1:1 Threshold Value 

Under 1:1 verification mode, the verification will only be successful when the 

similarity between the acquired facial image and the facial templates enrolled in 

the device is greater than the set value. 

The valid value ranges from 0 to 100. The higher the thresholds, the lower the 

misjudgement rate and higher the rejection rate, and vice versa. The default 

value of 63 is recommended. 

Face Enrollment 

Threshold 

During face enrolment, 1:N comparison is used to determine whether the user 

has already registered before. 

When the similarity between the acquired facial image and all registered facial 

templates is greater than the set threshold, it indicates that the face has already 

been registered. 

Face Pitch Angle  

It is the pitch (top to bottom and vice-versa) angle tolerance of a face for facial 

registration and comparison. 

If a face’s pitch angle exceeds the set value, it will be filtered by the algorithm, 

i.e., ignored by the terminal and no registration or comparison interface will be 

triggered. 

FRR FAR 

Recommended 

matching thresholds 

1:N 1:1 

High Low 48 42 

Medium Medium 46 40 

Low High 43 38 
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Face Rotation 

Angle  

It is the rotation angle tolerance of a face for facial template registration and 

comparison. 

If a face’s rotation angle exceeds this set value, it will be filtered by the algorithm, 

i.e., ignored by the terminal and, no registration and comparison interface will 

be triggered. 

Image Quality 
It sets the image quality for facial registration and comparison. The higher the 

value, the clearer the image required. 

Minimum Face Size 

It is required for facial registration and comparison. If an object’s size is smaller 

than this set value, it will be filtered and not recognized as a face. 

This value can be understood as the face comparison distance. The farther the 

person is, the smaller the face will be, and the smaller the face pixel will be 

obtained by the algorithm. Therefore, adjusting this parameter can adjust the 

furthest comparison distance of faces. When the value is 0, the face comparison 

distance is not limited. 

LED Light Trigger 

Value 

It controls the turning on and off of the LED light. The larger the value, the more 

frequently the LED light will be turning on. 

Motion Detection 

Sensitivity 

It is the measurement of the amount of change in a camera’s field of view that 

qualifies as potential motion detection that wakes up the terminal from standby 

to the comparison interface. The larger the value, the more sensitive the system 

would be, i.e., if a higher value is set, the comparison interface is much easily and 

frequently triggered. 

Live Detection  
It detects a spoof attempt by determining whether the source of a biometric 

sample is a live human being or a fake representation using visible light images. 

Live Detection 

Threshold 

It helps to judge whether the visible image comes from an alive body. The larger 

the value, the better the visible light anti-spoofing performance. 

Anti-spoofing using 

NIR 

It uses near-infrared spectra imaging to identify and prevent fake photos and 

videos attack. 

Face Algorithm Facial algorithm related information and pause facial template update. 

Note: 

Improper adjustment of the exposure and quality parameters may severely affect the performance of the 

device. Please adjust the exposure parameter only under the guidance of the after-sales service personnel 

of our company.  
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 Fingerprint Parameters 

Select Fingerprint option on the System interface. 

 

Item Descriptions 

1:1 Threshold 

Value 

Under 1:1 verification method, the verification will only be successful when the similarity 

between the acquired fingerprint data and the fingerprint template associated with the 

entered user ID enrolled in the device is greater than the set threshold value. 

1:N Threshold 

Value 

Under 1:N verification method, the verification will only be successful when the similarity 

between the acquired fingerprint data and the fingerprint templates enrolled in the 

device is greater than the set threshold value. 

FP Sensor 

Sensitivity 

To set the sensibility of fingerprint acquisition. It is recommended to use the default level 

“Medium” in normal conditions. When the environment is dry, resulting in slow 

fingerprint detection, you can set the level to “High” to raise the sensibility; when the 

environment is humid, making it hard to identify the fingerprint, you can set the level to 

“Low“.  

1:1 Retry 

Attempts 

In 1:1 Verification, users might forget the registered fingerprint, or press the finger 

improperly. To reduce the process of re-entering user ID, retry is allowed. 

Fingerprint 

Image 

To choose whether to display the fingerprint image on the screen during fingerprint 

enrolment or verification. Four choices are available: 

Show for enrol: To display the fingerprint image on the screen only during enrolment.  

Show for match: To display the fingerprint image on the screen only during verification.  

Always show: To display the fingerprint image on the screen during enrolment and 

verification.  

None: Not to display the fingerprint image.  

  

FRR FAR 

Recommended matching 

thresholds 

1:N 1:1 

High Low 45 25 

Medium Medium 35 15 

Low High 25 10 
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 Factory Reset 

Restore the device settings to their factory state, such as communication settings, system settings, etc. 

(Do not clear registered user data). 

Select the Reset option on the System interface. Select OK to reset. 

 

 USB Upgrade 

Insert the U disk with upgrade file into the device’s USB port, and in the initial interface, press [M/OK] > 

System > USB Upgrade to complete firmware upgrade operation. 

Select USB Upgrade option on the System interface. 

 

Note: If an upgrade file is needed, please contact our technical support. Deny firmware upgrade under 

normal circumstances.  
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7 Personalize Settings  

You may customize interface settings under this option. 

Select Personalize option on the main menu interface. 

 

 Interface Settings 

You can customize the display style of the main interface. 

Select User Interface option on the Personalize interface. 

 

Item Description 

Wallpaper To select the main screen wallpaper according to your personal preference. 

Language To select the language of the device. 
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Menu Screen 

Timeout (s) 

When there is no operation on the device, and the time exceeds the set value, then 

the device will automatically go back to the initial interface. You can disable the 

function or set the value between 60 and 99999 seconds. 

Idle Time To Slide 

Show (s) 

When there is no operation on the device, and the time exceeds the set value, a 

slide show starts to play. It can be disabled, or you may set the value between 3 and 

999 seconds. 

Slide Show 

Interval (s) 

It refers to the time interval for switching slide show pictures. The function can be 

disabled, or you may set the interval between 3 and 999 seconds. 

Idle Time to Sleep 

(m) 

If sleep mode is activated when there is no operation, the device enters standby 

mode. Press any key or finger to resume normal working mode. You can disable this 

function or set a value within 1-999 minutes.  

Main Screen Style To select the main screen style according to your personal preference. 

 Voice Settings 

Select Voice on the Personalize interface.  

 

Item Description 

Voice Prompt 
Select whether to enable voice prompts during operating, press [M/OK] to enable 

it. 

Touch Prompt 
Select whether to enable keyboard voice while pressing keyboard, press [M/OK] to 

enable it. 

Volume 
Adjust the volume of device. Press  key to increase the volume, press  key to 

decrease the volume. 
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 Bell Schedules Settings 

Many companies choose to use the bell to signify on-duty and off-duty time. When reaching the scheduled 

time for the bell, the device plays the selected ringtone automatically until the ringing duration passes. 

Select Bell Schedules option on the Personalize interface. 

 

 Add a Bell 

Select New Bell Schedules option on the Bell Schedules interface. Press [M/OK] Bell Status to enable the 

bell status. 

   

1. You can manually set the date and time and press [M/OK] to save. 

2. Set repeat, select a ring tone, and select the internal bell delay. 
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 Edit Bell 

On the All Bell Schedules interface, select the bell item to be edited. 

   

Select Edit to edit the bell schedule time. The editing method is the same as that of a new bell. 

 Delete a Bell 

On the All Bell Schedules interface, select a bell item to be deleted. 

   

Select Delete and select [Yes] to delete the bell schedule. 
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 Punch States Options 

Select Punch State Options on the Personalize interface. 

 

Item Description 

Punch State Mode 

 

Select a punch state mode under this menu option. The options are:  

Off: Select this to keep the punch state key function disabled. The punch state 

key set under the Shortcut Key Mappings menu becomes invalid. 

Manual Mode: Select to switch the punch state key manually, and the punch 

state key disappears after Punch State Timeout. 

Auto Mode: To make this mode work correctly, the switching time of the 

punch state key needs to be set in the Shortcut Key Mappings. After that, the 

punch state is automatically fetched by the device according to the switching 

time in the Shortcut Key Mapping. 

Manal and Auto Mode: In this mode, the main interface displays the auto-

switching punch state key, meanwhile supports manual switching of the 

punch state key. After the timeout, the manual switching punch state key 

becomes an auto-switching punch state key. 

Manual Fixed Mode: In this mode, the punch state key remains unchanged 

until it is switched manually next time. 

Fixed Mode: It only displays the fixed punch state key, and it cannot be 

switched. 

Punch State 

Timeout(s) 

It is the time for which the punch state displays. The value ranges from 5~999 

seconds. 

Punch State Required 

Select whether an attendance state needs to be selected after verification. 

ON: Attendance state needs to be selected after verification. 

OFF: Attendance state need not requires to be selected after verification. 
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 Shortcut Keys Mappings 

Shortcut keys can be defined as punch state keys or menu function key. When the device is on the main 

interface, pressing the set shortcut key will display the attendance state or enter the menu operation 

interface. 

Select the Shortcut Key Mappings option on the Personalize interface. 

   

To set Auto-Switching Time: 

Choose any shortcut key and select Punch State Options in Function to set the auto-switching time.  

Auto Switch: A different time interval is set for different Punch State options. When a set time reaches, the 

device switches its attendance state automatically. 

Note: 

When the shortcut key is set to Punch State Key, but OFF mode is selected in the Punch State Mode 

(Personalize > Punch State Options > Punch State Mode > Select OFF), then the shortcut key will not be 

enabled. 
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8 Data Management 

It helps to delete the relevant data in the device. 

Select Data Mgt. option on the main menu interface. 

 

 Delete Data 

Select Delete Data option on the Data Mgt. interface. 
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Item Description 

Delete Attendance Data To delete all attendance data in the device. 

Delete All Data To delete information and access records of all registered users. 

Delete Admin Role To remove administrator privileges.  

Delete Wallpaper To delete all wallpapers in the device. 

Delete Screen Savers To delete the screen savers in the device. 

Note: When deleting the access records, attendance photos, or blacklisted photos, you may select Delete 

All or Delete by Time Range. Selecting Delete by Time Range, you need to set a specific time range to 

delete all data with the period. 

 

 

 

Select Delete by Time Range  Set the time range and select Confirm(OK). 
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9 Department Management 

Establishing an organizational structure of the company and arranging departments shift is necessary to 

view the department information of the device. In this menu option, you can add, edit, or remove a 

department. 

Select Department on the main menu interface.  

 

 Add a Department 

1. Select Add Dept. and press [M/OK] to enter. 
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2. Select Dept. Name and enter the department name using the T9 input method. 

 

3. Select the Dept. Shifting of the department.  

 

Note:  

1. The equipment will automatically assign numbers to departments, starting from 1 and so on. 

2. Dept. Shift: Select the shift attendance used by all users of the department. Shifts can be set in Shift 

set > Shifts setting, with a maximum of 24 shifts set by default. Refer to Shift Set section. 
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 Edit a Department 

There are 8 departments in the device by default. You can edit the department name and department shift, 

but you cannot delete them. In addition to the 8 default departments, additional departments can be edited 

and deleted. 

 

1. Select Dept. Lists and press [M/OK] to enter. 

 

2. Select a department to edit and press [M/OK] to enter. 

 

3. Modify Dept. Name and Dept. Shifting and press [M/OK] to save. 

The editing of the department is the same as of Add Dept. 
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 Delete a Department 

It helps to remove one or more department as required. 

 

1. Select Dept. Lists and press [M/OK] to enter. 

 

2. Select a department to delete and press [M/OK] to enter. 

 

3. Select Delete and press [M/OK]. 

Note: Only departments other than the 8 default departments in the device can be deleted. 
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10 Shift Set 

Set attendance rules, number of shifts to be used, and schedule employees. 

Select Shift Set option on the main menu interface. 

 

 Attendance Rule 

All attendance statistics are conducted according to the attendance rules. Therefore, the staff attendance 

rules need to be set first, including late, early leave calculation method, and scheduling type. Once the 

attendance rules are set, it is not recommended to modify them frequently as it may affect the result of 

attendance calculation and may cause chaos in the scheduling if it is modified in the middle of the month. 

Select Attendance Rule on the Shift Set interface.  
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Item Descriptions 

Count Late On-duty 
Set a time after which the lateness calculation for an employee should start. 

If it is disabled, the lateness calculation starts with the start of working hours. 

Count Leave Off-duty 
Set a time before which the early leave calculation for an employee should 

start. If disabled, it is calculated with respect to the end of the working hours. 

Schedule Type 

The device supports both department and individual-based scheduling. 

If a company uses one timetable, then only one department needs to be set 

and department-based scheduling is recommended. 

If the departments have their respective timetables, department-based 

scheduling is recommended. 

If employees may take different shifts, individual-based scheduling is 

recommended. 

Default Shift 
When individual-based scheduling is used, the default shift applies to all the 

non-scheduled employees. 

SAT On-duty Enable whether to work normally on Saturdays. 

SUN On-duty Enable whether to work normally on Sundays. 

 Shift Setting 

Select Shift Setting on the Shift set interface. 

 

Select a Shift on the list, and press [M/OK]. 
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Use the T9 input method to enter "Shift Name” and set the required start and end times. 

 

Note: The device supports a maximum of 24 shifts including two default shifts (Shift 1 and Shift 2). All the 

shifts are editable, and a single shift includes three-time ranges at most. 

 Schedule 

The shifts should be set based on the actual condition of a company. If no shift is set, the system makes 

attendance calculations based on default shifts set in attendance rules.  

Select Schedule on the Shift Set interface.  
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 Department-based Scheduling 

Select Shift Set > Attendance Rule > Schedule Type > Dept. Shifting to schedule shift for a department. 

   

When a shift is selected for a department, it is implemented for all the members of the department. 

 Individual-based Scheduling 

Select Shift Set > Attendance Rule > Schedule Type > Personal Shift to schedule shift for an individual. 

1. Add Schedule 

1) Press [M/OK] to enter Schedule interface and select Add Personal Shift. 

 

2) Enter an ID. The device automatically displays the name. Select Shift Name and then press [M/OK]. 

 

3) Press [ESC] to exit and save.  
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2. Edit Schedule 

Enter the Personal Shift Lists for editing when the scheduling of individual employee needs to be adjusted. 

1) Select Personal Shift Lists on the Personal Shift interface. 

 

2) Select a scheduled user and press [M/OK]. 

 

3) Select Edit, press [M/OK] to enter and modify the "Shift Name" of the user. 

 

Note: The User ID cannot be modified. The other operations are the same as those performed to add a shift. 
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3. Delete a shift 

Go to the Personal Shift Lists, to delete an employee's schedule that is no longer required. 

1) Select Personal Shift Lists on the Personal Shift interface. 

 

2) Select a scheduled user and press [M/OK]. 

 

3) Select Delete, press [M/OK], and choose “OK” to delete the Shift successfully. 
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11 Report 

This menu item allows you to download statistical reports of attendance or attendance setting reports to a 

USB flash drive or SD card. You can also upload attendance setting reports with defined shifts and 

employees' schedules. The device gives priority to the schedules in an attendance setting report. 

Select Report on the main menu interface. 

 

Note: First insert the USB flash drive into the USB slot of the machine, and then enter the main menu to 

perform the related operations of the Report. 

 Download Att. Report 

Select Download Att. Report and press [M/OK]. 
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Set the on-duty time and press [M/OK]. 

 

Set the off-duty time and press [M/OK]. 

 

When Data download succeeds, Press [M/OK] to take out the USB disk or SD card. The SSRTemplateS.xls 

gets stored in the USB disk or SD card. The Schedule Information, Statistical Report of Attendance, 

Attendance Record Report, Exception Statistic Report, and Card Report can be viewed on a PC. The following 

reports show the preceding information: 

To make reports more understandable, a report containing two-day attendance records of four employees 

is provided as an example. 
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 Schedule Information Report: The report allows you to view schedule records of all employees.  

 

 Statistical Report of Attendance: The report allows you to query the attendance of each person in a 

specified period. Salaries can be calculated directly based on this report.  

 

Note: The unit of Work hour and Overtime hour in the Statistical Report of Attendance is HH: MM. For 

example, 17:50 indicates that the on-duty time is 17 hours and 50 minutes. 

 Attendance Record Report: The report lists the daily attendance records of all employees within a 

specified period. 

 

 Exception Statistic Report: The report displays the attendance exceptions of all employees within a 

specified period so that the attendance department handles the exceptions and confirm them with the 

employees involved and their supervisors.  
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 Card Report: The report can substitute for clock-based cards and can be sent to each employee for 

confirmation. 

 

 Download Att. Setting Report 

If shifts are complex or the shifts of a person are not fixed, it is recommended that the attendance setting 

report be downloaded and shifts and schedules be set for employees in the attendance setting report. 

Select Download Att. Setting Report and press [M/OK]. 

   

Open the setting "AttSettingE.xls" in the USB disk or SD card on a PC. Set the Shift in the Attendance setting 

report. The shifts that have been set on the attendance machine shall be displayed. (For more details, see 

Shift Setting. You can modify the 24 shifts and add more shifts. After modification, the shifts shall prevail on 

the attendance machine. 
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Set a schedule setting report 

Enter the ID, Name, and Department respectively on the left of the Schedule Setting Report. Set shifts for 

employees on the right of the Schedule Setting Report, where shifts 1–24 are shifts to set the Attendance 

Setting Report. Shift 25 is for leave and Shift 26 is for out. 

 

Notes:  

1. The shifts of only 31 days can be arranged in one schedule setting report. For example, if the scheduling 

date is 2020-1-1, the schedule setting report contains the schedules of 31 days after 2020-1-1, that is, 

scheduled from 2020-1-1 to 2020-1-31. If the scheduling date is 2020-1-6, the schedule setting report 

contains the schedules of 31 days after 2020-1-6, that is, scheduled from 2020-1-6 to 2020-2-5.  

2. If no schedule setting report is set, all employees use Report 1 by default from Monday to Friday. 

 Upload Att. Setting Report 

After setting the attendance setting table, save the “Setting Report.xls” to the USB flash drive and reinsert 

the USB flash drive into the USB slot of the device. 

  

  

Enter the On-duty and Off-duty time in the 

corresponding columns, where the First time zone 

shall be the On-duty or Off-duty time of Time 1 of 

Shift Setting, and the Second time zone shall be the 

On-duty or Off-duty time of Time 2. 

For the correct schedule time format, see "What is 

the correct time format used in the setting reports" 

in the "Self-Service Attendance Terminal FAQs." 
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Select Upload Att. Setting Report on the Report interface and press [M/OK]. 

   

After uploading, remove the USB disk or SD card. At this time, the employee information, shift, and 

department in the setting report can be viewed respectively by the Management User, Shift Number, and 

Department available in the device. Or the above information and scheduling information can be seen in 

the standard download report. 

Note: If the schedule time format is incorrect, Re-upload the attendance setting report after modification. 

 Setting 

Set whether to synchronize the card report and distinguish the device ID when downloading the attendance 

report. 

Select Setting on the Report interface and press [M/OK]. 
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12 Access Control 

Select Access Control on the main menu interface. 

 

 Access Control Options 

To set the parameters of the control lock of the terminal and related equipment. 

Select Access Control Options on the Access Control interface. 
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Item Description 

Door Lock Delay 

(s) 

The length of time that the device controls the electric lock to be unlocked. Valid 

value: 1~10 seconds (0 second represents disabling the function). 

Door Sensor 

Delay (s) 

If the door is not closed and locked after opening for a certain duration (Door Sensor 

Delay), an alarm will be triggered. The valid value of Door Sensor Delay ranges from 1 to 

255 seconds. 

Door Sensor 

Type 

There are three types of Door Sensor: None, Normal Open, and Normal Closed. 

None means door sensor is not in use; Normal Open means the door is always opened 

when powered; and Normal Closed means the door is always closed when powered. 

Door Alarm 

Delay (s) 

When the state of the door sensor is inconsistent with that of the door sensor type, 

alarm will be triggered after a certain time. This time is the Door Alarm Delay (the 

value ranges from 1 to 999 seconds). 

Speaker Alarm 
To transmit a sound alarm or disassembly alarm from the local. When the door is 

closed, or the verification is successful, the system cancels the alarm from the local.  
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13 USB Manager 

Upload or download data between the device and the corresponding software using a USB disk. 

Before uploading/downloading data from/to the USB disk, insert the USB disk into the USB slot first. 

Select USB Manager on the main menu interface. 

 

 USB Download 

Select Download on the USB Manager interface. 

 

Item Description 

Attendance Data Import all the attendance data from the device to a USB disk. 

User Data 
Import all the user information, fingerprints, and facial images from the device to a 

USB disk. 
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 USB Upload 

Select Upload on the USB Manager interface. 

 

Item Description 

Screen Saver 

To upload all screen savers from USB disk into the device. You can choose [Upload 

selected picture] or [Upload all pictures]. The images display as screensaver on the 

device’s main interface after upload. 

Wallpaper 

To upload all wallpapers from USB disk into the device. You can choose [Upload 

selected picture] or [Upload all pictures]. The images display as wallpaper after 

upload. 

User Data Upload the message stored in a USB disk to the terminal. 

 Download Options 

Select Download Options on the USB Manager interface. 

 

Click [M/OK] to enable or disable the [Encrypt Attendance Data] and [Delete ATT Data] options. 

With Encrypt Attendance data-enabled, the data downloads with encryption for better security.  

Delete ATT Data deletes all the attendance data. 
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14 Attendance Search 

When the identity of a user is verified, the record is saved on the device. This function enables users to check 

their access records. 

Select Attendance Search on the main menu interface and input the User ID. The interface is shown below. 

1) Enter the user ID to be searched and select 

OK. If you want to search for records of all 

users, select OK without entering any user ID. 

 2) Select the time range for the records you 

want to search. 

  

3) The record search succeeds. Select the 

record in green to view its details. 

4) The below figure shows the details of the 

selected record. 
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15 Autotest 

The auto test enables the system to automatically test whether the functions of various modules are working 

normally, including the LCD, voice, sensor, keyboard, and clock tests. 

Select Autotest option on the main menu interface. 

 

Item Description 

Test All To automatically test whether the LCD, audio, camera and RTC are working normally. 

Test LCD 

To automatically test the display of the LCD screen by displaying all the color bands 

including pure white and pure black to check whether the screen displays the colors 

accurately. 

Test Voice 
To automatically test whether the audio files stored in the device are complete and 

the voice quality is good. 

Test Keyboard 

The terminal tests whether every key on the keyboard works normally. Press any key 

on the [Keyboard Test] interface to check whether the pressed key matches the key 

displayed on the screen. The keys are displayed as dark grey before and turn blue 

after pressed. Press [ESC] to exit the test. 

Test 

Fingerprint 

Sensor 

The terminal automatically tests whether the fingerprint collector works properly by 

checking whether the fingerprint images are clear and acceptable. When the user 

places his/her finger in the fingered guide, the collected fingerprint image displays 

on the screen in real-time. Press [ESC] to exit the test. 

Test Face 
To test if the camera functions properly it checks the photos taken and determines if 

they are clear enough. 

Test Clock RTC 

To test the RTC. The device checks whether the clock works normally and accurately 

with a stopwatch. Touch the screen to start counting and press it again to stop 

counting. 
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16 System Information 

With the system information option, you can view the storage status, the version, and firmware information 

of the device. 

Select System Info on the main menu interface. 

 

Item Description 

Device 

Capacity 

Displays the current device's user storage, password, fingerprint and face storage, 

administrators, and attendance records. 

Device Info 

Displays the device's name, serial number, MAC address, face algorithm version 

information, fingerprint algorithm version information, platform information, and 

MCU version. 

Firmware Info Displays the firmware version and other version information of the device. 
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17 Connect to ZKBioAccess IVS Software 

 Set the Communication Address 

 Device side 

1. Tap COMM. > Ethernet in the main menu to set the IP address and gateway of the device. 

(Note: The IP address should be able to communicate with the ZKBioAccess IVS server, preferably in 

the same network segment with the server address)  

2. In the main menu, click COMM. > Cloud Server Setting to set the server address and server port.  

Server address: Set the IP address as of ZKBioAccess IVS server. 

Server port: Set the server port as of ZKBioAccess IVS(The default is 8088). 

                 

 Software side 

Login to ZKBioAccess IVS software, click System > Communication > Communication Monitor to set the 

ADMS service port, as shown in the figure below: 
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 Add Device on the Software 

Add the device by searching. The process is as follows: 

1. Click Attendance > Attendance Device > Device > Search, to open the Search interface in the 

software. 

2. Click Search, and it will prompt [Searching……]. 

3. After searching, the list and total number of access controllers will be displayed. 

 

4. Click Add in operation column, a new window will pop-up. Select Attendance Area and Time zone 

from each dropdowns and click OK to add the device. 
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 Add Personnel on the Software 

1. Click Personnel > Person > New: 

 

2. Fill in all the required fields and click OK to register a new user. 

3. Click Attendance > Attendance Device > Device > Control > Synchronize Software Data to the 

Device to synchronize all the data to the device including the new users. 

For more details, please refer to the ZKBioAccess IVS User Manual. 
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Appendix 

Self-Service Attendance Terminal FAQs 

1. Does self-service attendance terminal support scheduling based on every other day? 

A: No. 

2. Can the setting records downloaded from the device be edited on WPS software? 

A: Yes. Setting records are supported in Microsoft Office 2003, Microsoft Office 2007, and WPS Office 2012 

Personal.  

3. What is the attendance calculation flow adopted by the self-service attendance terminal? 

A: SSR attendance calculation flow. 

Obtain the EXCEL 

schedule record.

[Attendance rules] is 

the individual-based 

scheduling adopted?

Does the EXCEL 

schedule record exist?
NO

Obtain information about 

the department.

Obtain  department 

schedules.

 Do department 

schedules exist ?

Obtain individual 

schedules.

Do individual 

schedules exist ?
NO

[Attendance rules] Obtain 

default shifts.
NO

[Attendance rules] Obtain the rule concerning whether 

Saturday is a work day. Obtain the rule concerning 

whether Sunday is a work day.

YesYes

Yes

Make attendance 

calculations.

End

Start

NO

Yes
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4. How to calculate special overtime hours? 

The following cases are deemed special overtime: 

a) When an EXCEL schedule record exists and attendance reports are used for attendance calculation, 

there are check-in and check-out records though there is no schedule (or rest is arranged) for the 

current date.  

b) When no EXCEL schedule record is available, there are check-in and check-out records though Saturday 

and Sunday are non-working days.  

Overtime hours refer to the duration counted from the first check-in time to the last check-out time on the 

current day. 

5. How to arrange schedules using the attendance setting report? 

Step 1: Insert a USB flash drive into the USB port or SD card into the SD port of the device and download the 

Attendance Setting Report.xls to the USB flash drive or SD card.  

Step 2: Open the Attendance Setting Report.xls on a computer.  

Step 3: Set shifts in the Attendance Setting Report.xls as required. 

 

Step 4: Arrange schedules for employees.  

 

 

Note: Dates must be set correctly. For example, if the scheduling date is 2012-1-1, the schedule setting 

report contains the schedules of 31 days after 2012-1-1, that is, the schedule from 2012-1-1 to 2012-1-31. If 

the scheduling date is 2012-1-6, the schedule setting report contains schedules of 31 days after 2012-1-6, 

that is, the schedule from 2012-1-6 to 2012-2-5.  

Step 5: Insert a USB flash drive into the USB port or SD card into the SD port of the device and upload the 

Attendance Setting Report.xls to the device. Then, the schedules in the Attendance Setting Report can 

be used. 

 

Data enclosed by a red 
rectangle is new shifts 
(shift 3 and shift 4). To add 
a shift, enter a time 
directly, in the range of 
00:00 to 24:00.  

 

Holiday Leave On business Shifts 

Date 
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6. What is the correct time format used in the setting reports? 

A. The correct time format is shown in the following table. 

Shift No. 
First Time Range Second Time Range Overtime Range 

On-duty Off-duty On-duty Off-duty Check-in Check-out 

1 09:00 18:00     

2 09:00 12:00 13:30 18:00   

3 9:5 18:00     

B. Incorrect time formats are as follows: 

a) A time value is beyond the time range, such as 24:00. 

b) A time value contains Chinese characters, for example, 9:00, which differs from 9:00.  

c) A time value is preceded by a space. As shown in the following table, there is a space in front of 

09:00 in shift 1.  

Shift No. 
First Time Range Second Time Range Overtime Range 

On-duty Off-duty On-duty Off-duty Check-in Check-out 

1  09:00 18:00     

2 09:00 12:00 13:30 18:00   

3 9:5 18:00     

d) A time value contains special characters, for example, _9:00 and 09:-1.  

The device performs a validity check and error tolerance for other formats.  

7. How does the self-service attendance terminal collect the correct attendance time based on the 

preset shift time? 

A: The device collects attendance time based on the following principles: 

a) Adopt the earliest time for normal attendance and the nearest time for abnormal attendance. 

b) Adopt the normal attendance time if the normal attendance time and abnormal attendance time 

coexist. 

c) Adopt a median in the attendance time range.  
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B: The following uses four examples to describe the preceding principles.  

Example 1: Normal attendance 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 

employee 
8:30, 8:35, 11:55,12:01, 12:50, 18:02,19:00 

Statistical result based on 

attendance rules 
8:30 12:01 12:50 18:02   

Description: The attendance time 8:30 and 8:35 are earlier than the on-duty time 9:00 and they are within 

the normal attendance time range. Therefore, 8:30 is adopted for the on-duty time 9:00 based on the 

principle of adopting the earliest time for normal attendance. 18:02 and 19:00 are later than the off-duty 

time 18:00, and therefore, 18:02 is adopted based on the same principle.  

 

Example 2: Late arrival 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 

employee 
9:01, 9:04, 12:01, 12:50, 18:00 

Statistical result based on 

attendance rules 
9:01 12:01 12:50 18:00   

Description: Employer 1 checks in for work at 9:01 and 9:04 and he/she is late based on the preset on-duty 

time. Based on the principle of adopting the nearest time for abnormal attendance, the correct check-in 

time is 9:01 rather than 9:04 because of 9:01 is nearer 9:00. 

Example 3: Early leave 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 

employee 
8:50, 11:40,11:55, 12:50, 18:01 

Statistical result based on 

attendance rules 
8:50 11:55 12:50 18:01   

Description: The attendance time 12:50 is adopted based on the principle of adopting a median in the 

attendance time range. For the attendance time range from 9:00 to 12:00, the normal check-out time range 

for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 12:00 + (13:00 - 12:00)/2). Therefore, the calculated 

time of attendance is shown in the preceding table.  
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Example 4: Absence 

Case 1: 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00  

Attendance time of #1 

employee 
8:50, 12:50, 18:01 

Statistical result based on 

attendance rules 
8:50  12:50 18:01   

Description: The attendance time 12:50 is adopted based on the principle of adopting a median in the 

attendance time range. For the attendance time range from 9:00 to 12:00, the normal check-out time range 

for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 12:00 + (13:00 - 12:00)/2). Therefore, the check-out 

time is blank. The normal check-in time range for the on-duty time from 13:00 is from 12:30 to 13:00. The 

calculated time of attendance is shown in the preceding table.  

Case 2: 

Attendance Time Range 09:00 — 12:00 13:00 — 18:00   

Attendance time of #1 

employee 
8:50, 11:55, 12:20, 18:01  

Statistical result based on 

attendance rules 
8:50 12:20  18:01    

Description: The time 12:20 is adopted based on the principle of adopting a median in the attendance time 

range. The normal check-out time range for the off-duty time 12:00 is from 12:00 to 12:30 (that is, 12:00 + 

(13:00 - 12:00)/2). Therefore, the check-out time of the employee is 12:20. The normal check-in time range 

for the on-duty time from 13:00 is from 12:30 to 13:00. Therefore, the check-in time of the employee is blank. 

The calculated time of attendance is shown in the preceding table. 
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Statement on the Right to Privacy  

Dear Customers: 

Thank you for choosing this hybrid biometric recognition product, which was designed and manufactured 

by ZKTeco. As a world-renowned provider of core biometric recognition technologies, we are constantly 

developing and researching new products, and strive to follow the privacy laws of each country in which 

our products are sold. 

We Declare That: 

1. All of our civilian fingerprint recognition devices capture only characteristics, not fingerprint images, 

and do not involve privacy protection. 

2. None of the fingerprint characteristics that we capture can be used to reconstruct an image of the 

original fingerprint, and do not involve privacy protection. 

3. As the provider of this device, we will assume no direct or indirect responsibility for any consequences 

that may result from your use of this device. 

4. If you would like to dispute human rights or privacy issues concerning your use of our product, please 

directly contact your dealer. 

Our other law-enforcement fingerprint devices or development tools can capture the original images of 

citizen's fingerprints. As to whether this constitutes an infringement of your rights, please contact your 

Government or the final supplier of the device. As the manufacturer of the device, we will assume no legal 

liability. 

Lastly, we would like to further emphasize that biometric recognition is an advanced technology that will 

be certainly used in E-commerce, banking, insurance, judicial, and other sectors in the future. Every year the 

world is subjected to major losses due to the insecure nature of passwords. The Biometric products serve to 

protect your identity in high-security environments. 
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Eco-friendly Operation 

 
The product's "eco-friendly operational period" refers to the time during which this product 
will not discharge any toxic or hazardous substances when used in accordance with the 
prerequisites in this manual. 

The eco-friendly operational period specified for this product does not include batteries or 

other components that are easily worn down and must be periodically replaced. The battery's 

eco-friendly operational period is 5 years. 

Hazardous or Toxic substances and their quantities 

Component 
Name 

Hazardous/Toxic Substance/Element 

Lead (Pb) 
Mercury 

(Hg) 
Cadmium 

(Cd) 

Hexavalent 
chromium 

(Cr6+) 

Polybrominated 
Biphenyls (PBB) 

Polybrominated 
Diphenyl Ethers 

(PBDE) 

Chip Resistor × ○ ○ ○ ○ ○ 

Chip Capacitor × ○ ○ ○ ○ ○ 

Chip Inductor × ○ ○ ○ ○ ○ 

Diode × ○ ○ ○ ○ ○ 

ESD 
component × ○ ○ ○ ○ ○ 

Buzzer × ○ ○ ○ ○ ○ 

Adapter × ○ ○ ○ ○ ○ 

Screws ○ ○ ○ × ○ ○ 

○ indicates that the total amount of toxic content in all the homogeneous materials is below the limit 
as specified in SJ/T 11363—2006. 

× indicates that the total amount of toxic content in all the homogeneous materials exceeds the limit 
as specified in SJ/T 11363—2006. 

Note: 80% of this product’s components are manufactured using non-toxic and eco-friendly materials. 
The components which contain toxins or harmful elements are included due to the current economic 
or technical limitations which prevent their replacement with non-toxic materials or elements. 



 

 

 

 

 

ZKTeco Industrial Park, No. 32, Industrial Road,  

Tangxia Town, Dongguan, China. 

Phone  : +86 769 - 82109991  

Fax   : +86 755 - 89602394 

www.zkteco.com 
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